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Abstract 
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Preface 

Overview 

u-center is u-blox’s powerful GNSS evaluation and visualization tool which can be downloaded free-of-charge 

from our website (www.u-blox.com). This user guide provides a description of the features of this software. It 

allows end users to assess and test u-blox GNSS positioning chips and modules for navigation and positioning 
performance.  

The purpose of u-center is to enable users to: 

 Conduct performance tests on u-blox and other GNSS devices. 

 Configure u-blox GNSS positioning chips and modules. 

 Update the firmware on GNSS modules. 

 Test the added performance provided by u-blox’s AssistNow service. 

Using this guide 

This guide assumes that the user has basic computer skills and is familiar with the Windows Graphical User 
Interface (GUI) and GNSS receiver environments. 

The following symbols are used to highlight important information: 

 An index finger points out key information pertaining to integration and performance. 

 A warning symbol indicates actions that could negatively impact or damage the receiver. 

Technical support 

If you have questions about installing or using u-center: 

 Read this user guide carefully. 

 Check our homepage (http://www.u-blox.com) to ensure that your GNSS device, firmware and the u-center 

software are the latest versions.  

 Refer to our web based information service. 

Worldwide Web 

Our website (www.u-blox.com) is a rich pool of information. Product information and technical documents can 

be accessed 24/7. 

By email 

If you have technical problems or cannot find the required information in the provided documents, contact the 

closest technical support office. To ensure that we process your request as soon as possible, use our service pool 
email addresses rather than personal staff email addresses. Contact details are at the end of the document. 

Helpful information when contacting technical support 

When contacting technical support, have the following information ready: 

 Receiver type (e.g. NEO-7N), firmware version (e.g. 1.00), and u-center release (e.g. u-center 8.00) 

 Receiver configuration and short description of the application 

 Your complete contact details 

http://www.u-blox.com/
http://www.u-blox.com/
http://www.u-blox.com/
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1 Features 
u-center evaluation software provides system integrators and end users with a quick and simple way to interface 

with u-blox GNSS chipsets, modules and boards. It enables easy evaluation, performance testing, development 
and debugging of GNSS positioning chips and modules. u-center allows easy connection to u-blox products and 

provides a suite of features to view, log, and analyze performance. The features include: 

 Support for u-blox’s receivers using u-blox positioning technology. u-center can communicate with these 
receivers using either the UBX protocol or the NMEA-0183 standard protocol. 

 Support for receivers that utilize standard NMEA strings. 

 u-center presents all the information collected during the operation of the GNSS device. All aspects of GNSS 

data (position, velocity, time, satellite tracking, etc.) can be monitored and logged under various test 

scenarios for the evaluation of a receiver. u-center software allows analysis of the collected data in order to 
investigate performance issues such as accuracy, road test position and trajectory, satellite tracking, time to 

first fix, etc. All processed data can be captured in ASCII format and ported into popular spreadsheets for 

creating additional plots and statistics. 

 Camera View: photographic data can be stored in the log file together with the navigation data and later be 

replayed in the application. 

 Export data files to Google Earth and Google Maps. 

 Supports (Multiple GNSS) AssistNow Online and AssistNow Offline. 

 Data recording and playback function. 

 Structural and graphical data visualization in real-time. 

 Export functionality to standard PC applications. 

 Docking views (real-time cockpit instruments): 
Satellite constellation, compass, clock, altimeter, speedometer, GNSS and satellite information views. 

 Download firmware updates to GNSS positioning modules. 
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2 Getting started 

2.1 General information about displayed values 

 Longitude and latitude are displayed according to the datum selected in the GNSS device (usually: WGS-84). 

This option can be polled and set using the UBX-CFG-DAT message. 

 Time is displayed with reference to UTC. 

 Elevation is displayed with reference to either MSL (Height above mean sea level or Orthometric Height) or 

to HAE (Height above WGS-84 ellipsoid). The reference is controlled by the GNSS configuration. 

2.2 Connecting a u-blox evaluation kit to the PC 

This section assumes that you have purchased a u-blox evaluation kit. Should you try to connect a different 

GNSS device to the PC, make sure you use appropriate RS-232 level shifters. 

The evaluation kit can be connected to the PC by using either an USB or a serial cable. In case of using the USB 

port, a driver is required (contained in the u-center installer or downloadable from our homepage). Be sure to 

install the driver before connecting the evaluation kit to the computer. 

2.3 Installing u-center 

The installation program guides you through the necessary steps for a successful program installation. During the 

installation, you can choose the destination folder for the program. 

 u-center uses dynamic link libraries (DLL). The installation program will automatically install the 

required DLLs into the u-center program directory. Should you try to copy a u-center installation 

from one location to another after the installation, make sure you copy the DLL files as well. 

After a successful installation, u-center can be started from the Start Menu (All Programs  u-blox  u-center 

 u-center) and will start up as shown in Figure 1. 

 

Figure 1: Start display 
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2.4 Connect to the receiver 

2.4.1 Select the port 

Locate the communication toolbar (Figure 2) and click on the arrow beside the  icon. This will show a list with 
all available COM ports (Figure 3). Select the corresponding COM port where the receiver is connected. If a link 

could be established, the icon will turn green  and the text in the status bar changes from  

to  (in this example u-center is connected to COM6). This does not mean that the 
communication already works but only that the port could be opened. 

 

Figure 2: Communication toolbar 

 

Figure 3: List of available COM ports 

2.4.2 Select the baud rate (only for COM ports) 

Again in the communication toolbar, click on the arrow beside the  icon. This will show a list with all available 

baud rates (Figure 4). Select the correct baud rate on which the receiver is communicating (typically 9600 baud). 

If u-center is able to decode data from the receiver, the status bar begins to blink in green as shown in the 

following icon: . This means that the connection is established successfully and the 

communication between the receiver and u-center is working. 

 

Figure 4: List of available baud rates 

You are now ready to use the receiver. 
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3 Concept and philosophy 
Understanding the basic concept behind u-center is important in order to get the highest benefit out of this 

powerful evaluation software. Figure 5 depicts the architecture of the software. The program gets a data stream 
from either a COM port or a log file and splits this stream into protocol messages. From the messages, relevant 

parameters are extracted and inserted into the current dataset of the database. 

In the current dataset, statistical values of the parameters are calculated. Average, Minimum, Maximum and 
Standard Deviation are calculated for most parameters. If a protocol does not provide a parameter, u-center tries 

to calculate the parameter from the ones that are available. For example if velocity-north and velocity-east are 

available, u-center calculates the speed over ground and course over ground, unless this data is already available 
in the protocol. 

 

Figure 5: Engine Architecture 

When a new epoch (change in time) is detected, the current dataset is stored as history in the database. This 
history has a limited size. If the size is exceeded u-center keeps only the latest datasets and the oldest ones are 

removed. The history size may be adjusted. Refer to section 5.4 for the details 

u-center provides various view classes for observation. Most views take their data from the database, but some 
get their data directly from the message without using the database at all. The other views are updated when 

the database changes. 

 

 Message Views Displays and decodes a copy of every known message. This view allows observing a single 

message in detail and it may also be used to configure the GNSS device. Refer to Section 6.2.5 for details. 

The configuration view is a subset of the message view and only displays message to configure the receiver. 
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 Console Views Displays the messages in text form. They are particularly useful for users to develop GNSS 
firmware code. There is also a wide range of information available which is useful for evaluation and testing. 

Refer to sections 6.2.1, 6.2.2 and 6.2.3 for details. 

 Graphical Views Displays parameters from the database in graphical form. Charts (see section 6.2.9), 
Histograms (section 6.2.10) and a Map Overlay (section 6.2.8) can be created. There are two more views 

(Deviation View and Sky View, see sections 6.2.12 and 7.1.1) that may be used for statistical performance 
and antenna pattern analysis. 

 Tabular Views Shows the parameters of the database in tabular form. They can be freely configured to 

allow customized tables. Refer to sections 6.2.6 and 6.2.7 for details. 

 Docking Windows Can be docked to the frame of u-center. An analog watch, compass, world map, 

altitude and speed meter are available. There are also docking windows showing the current signal power 

and the constellation of the satellites received by the device as well as a summary of the GNSS status. 

 

 Displaying various views and docking windows requires computing power. Minimizing or closing them 
may significantly reduce CPU usage. 

3.1 Color and satellite coding scheme 

In the graphical views and some docking windows, colors are used to indicate data quality. Table 1 shows the 

color codes for graphical views depending on the quality of the navigation solution. 

 

Color Meaning 

+ Yellow Current value 

+ Orange Valid 3D navigation fix + Dead Reckoning 

+ Green Valid 3D navigation fix 

+ Cyan Valid 2D navigation fix 

+ Magenta Dead Reckoning Fix 

+ Blue Degraded navigation fix  

+ Red No or invalid navigation fix 

Table 1: Color-coding scheme for graphical views 
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Table 2 gives the color-coding scheme for the Docking Windows and Sky View. It indicates the state of each 
satellite.  

Color  Meaning 

 Green Satellite used in navigation (with Ephemeris) 

 4 Olive 5 Satellite used in navigation (with Ephemeris and PPP) 

 

5.1 Dark 
Gree

n 

5.2 Satellite used in navigation (with aiding data: AssistNow Autonomous, AssistNow 
Online/Offline) 

 
5.2.1 Cya

n 
5.2.2 Satellite signal available, available for use in navigation 

 

5.2.2.1 Bl
u

e 

5.2.2.2 Satellite signal available, not available for use in navigation 

 

5.2.2.2.1 R
e

d 
5.2.2.2.2 Satellite signal not available 

Table 2: Color-coding scheme for the docking windows and sky view 

Table 3 gives the satellite-coding scheme for the docking windows and sky view. 

Satellite Code System 

Gxx GPS 

Rxx GLONASS 

Bxx BeiDou 

Exx Galileo 

Sxx SBAS 

Qxx QZSS 

Table 3: Satellite-coding scheme for the docking windows and sky view 

Figure 6 shows the color legend. This is available under: Tools  Preferences  Status Colors. 
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Figure 6: Color-coding scheme for graphical views, docking windows, and sky view 
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5.3 Operating modes 

u-center has different operating modes (see Figure 7). The mode changes when you open or close a log file or 

when you make an action in the player. To be able to use the record mode you have to create a new file, save to 
a new file or open an existing file. The record and player mode are only available if you have created a new file 

or when you have opened a write-able file. 

 

Figure 7: Relations between operating modes 

5.3.1 Online mode 

In this mode a GNSS device is directly connected to u-center via a COM port. u-center can control and configure 

the receiver and it will display the data that the receiver is sending periodically. 

5.3.2 Stop mode 

In this mode no data from a receiver or a log file is forwarded to the database and views. u-center is in this 

mode when a log file is open but player and recorder are not active. 

5.3.3 Recorder mode 

Recorder Mode is the same mode as the Online Mode, except u-center additionally creates a log file, 

concatenating all the messages sent by the receiver. You enter this mode by creating a new log file or opening 
an existing log file without write protection and pressing the record button. An example of using this mode 

would be to make overnight measurements and evaluate the data at a later time. u-blox customer support may 

request a log file from you when you are experiencing a problem with one of our receivers. 

5.3.4 Player mode 

The Player Mode allows replaying a previously recorded log file step by step, in real-time or at an accelerated 

rate. You enter this mode by opening a file and pressing the play, step or scan button. 
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5.3.5 Relations between modes 

The operating mode depends on the status of the log file player. Modes are changed by user actions. Each mode 

has different states that are changed by a user action or by an event (see Figure 7). 

In Online and Recorder modes, u-center displays data from the receiver. In Player mode data from a log file is 
displayed. Player mode has different states. In Play state messages are read and displayed periodically from the 

log file. The very intuitive user interface is derived from that of a CD player. u-center updates the views after 

each message. Step state only gets one message from the log file and immediately returns to paused Play state. 
Scan state also reads messages periodically but the display is only updated when paused or by changing the 

state. Position can be set in a log file. This behaves differently in the Player and Stop modes. In Stop mode the 

position is just set and no data is read and displayed. u-center will start recording or playing from that position 
when changing the mode. If position is set in Player mode, u-center will load the data up to this position from 

the log file and display the contents. 

5.4 Database limitation 

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of large log files. The 

limit is set to 1800 epochs by default. This means if an epoch is available every second you can analyze data for 
up to 30 minutes. After this time the oldest values are discarded. Data stored to a log file is not affected by the 

database limitation.  

                 

 

Figure 8: Set maximum number of epochs to keep in database 

  For long-term observations, it’s recommended to start recording a log file before analysis begins. 

 If a high value of epochs is selected, the display of data in real-time cannot be guaranteed, 
especially when graphical views are open. 
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6 u-center menus and windows 

6.1 Main frame and toolbars 

The main frame is the primary display screen of u-center. It displays all tool bars and some of the information 

provided by the device. In the standard status bar, information about communication, UTC time, connection 

time, used protocol (NMEA or UBX), used file, etc. is shown. 

 Button tool tip: A description about each button in the toolbars can be obtained by holding the mouse 

cursor over the button for a few seconds. A tool tip message will appear near the icon with additional 

information while a detailed description is displayed in the status display. 

 

 

Figure 9: u-center main frame and toolbars 

6.1.1 Standard menu bar 

All u-center functions can be accessed through the standard menu bar. Commands can also be accessed by 
shortcuts that are listed in the menus. Some often used operations are also available in the different toolbars. 
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6.1.1.1 File 

 

Figure 10: File menu entries 

Function Description Shortcut / Toolbar icon 

New… 

Creates a new log file. No data is yet written but only the file is 
opened. The duration of the logging time is displayed in the 
status bar field Operating time. 

Ctrl+N /  

Save… 

Creates a new log file, saves the data from the internal database 
to the log file and starts immediately recording all new data from 

the receiver. This is useful when an error or an unexpected event 

occurred and no log file was recorded. The size of the ring buffer 
(4 MB) is large enough to retain the data for the last hour 
(approx.). 

Ctrl+S /  

Open… Opens a stored log file to be replayed. Ctrl+O 

Close Closes the active file. Ctrl+E /  

Database Empty Deletes the internal database and all saved values.  

Database Export 
Exports the internal database into HTML or KML data formats for 
displaying with Google Map or Google Earth. 

 

Print… Prints the active document.  

Print Preview Shows a preview of the print output.  

Print Setup… Shows the setup dialog of the printer.  

Recent Files Lists all recently used files.  

Exit Exits u-center.  

Table 4: File menu entries 
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6.1.1.2 Edit 

 

Figure 11: Edit menu entries 

Function Description Shortcut / Toolbar icon 

Cut Cut the current selection and put in to the clipboard Ctrl+X / Shift+Del /  

Copy Copy the current selection to the clipboard Ctrl+C / Ctrl+Insert /  

Paste Paste the clipboard content to the current position Ctrl+V / Shift+Insert /  

Delete Delete the current selection Del 

Select All Select all in the current view Ctrl+A 

Clear All Clear all in the current view Ctrl+Del 

Table 5: Edit menu entries 

The Edit menu is fully Microsoft Windows compliant. 
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6.1.1.3 View 

 

Figure 12: View menu entries 

Function Description Shortcut / Toolbar 

icon 

Packet Console Opens the packet console. 
F6 /  

Binary Console Opens the binary console. 
F7 /  

Text Console Opens the text console. 
F8 /  

Messages View Opens the dialog with all supported messages. F9 /  

Configuration View Opens the dialog with all configuration messages. This is a subset of the 
Messages View. 

Ctrl+F9 /  

Statistic View Opens the statistic view with all data from the internal database. F10 /  

Table View Opens the empty table view. All values from the internal database can 
be displayed individually. 

F11 /  
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Recent Table Views Lists all the table views that have been opened. This information comes 
from the Windows registry and is also valid after a restart of u-center. 

 

Map View Opens a window allowing to display a map.  

Recent Map Views Lists all the maps views that have been opened. This information comes 
from the Windows registry and is also valid after a restart of u-center. 

 

Chart View Opens a window with chart functionality. All values from the internal 
database can be displayed individually. 

 

Recent Chart View Lists all the chart views that have been opened. This information comes 
from the Windows registry and is also valid after a restart of u-center. 

 

Histogram View Opens a window with histogram functionality. All values from the 
internal database can be displayed individually. 

 

Recent Histogram 
View 

Lists all the histogram views that have been opened. This information 
comes from the Windows registry and is also valid after a restart of u-

center. 

 

Camera View Opens a window allowing to connect to a webcam and visualize and 
save the image. 

 

Deviation Map Opens a window with a position deviation map. 
F12 /  

Sky View Opens a window with the sky view. The current position of the satellites 
and their values from the internal database are shown. 

 

Docking Windows Opens a list with all available docking windows that can be shown.  

Satellite Position Shows or hide the current satellite positions.  

Satellite Level Shows or hide the current satellite levels.  

Satellite Level 
History 

Shows or hide the history of the satellite levels.  

World Position Shows or hide the current position on the world map.  

Data 
Shows or hide data from the navigation solution (like position, TTFF, 
accuracy and DOPs)  

Altitude Meter Shows or hide the altitude meter.  

Compass Shows or hide the compass.  

Speed Meter Shows or hide the speed meter.  

Watch Shows or hide the clock.  

Toolbars Opens a list with all available toolbars that can be shown.  

Standard Toolbar Shows or hide the standard toolbar.  

Views Toolbar Shows or hide the views toolbar.  

Receiver Toolbar Shows or hide the receiver toolbar.  

Player Toolbar Shows or hide the player toolbar.  

Action Toolbar Shows or hide the action toolbar.  

AssistNow Offline 
Toolbar 

Shows or hide the AssistNow Offline toolbar.  

Table 6: View menu entries 
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6.1.1.4 Player 

 

Figure 13: Player menu entries 

Function Description Shortcut / Toolbar icon 

Eject Closes the active log file Ctrl+E /  

Stop Stops reading or recording from the active log file Ctrl+H /  

Pause Pauses reading or recording from the active log file.  Ctrl+P /  

Record Starts recording to a new or already opened log file. Any data in 
the internal database will not be written to the file. If you want to 
save this data into a log file, open the File menu and click Save. 

Ctrl+R /  

Step Single step function. The next message is read. Ctrl+Space /  

Play Starts reading from the active log file. The speed of the action can 

be chosen on the sub-menu. 
Ctrl+G /  

Scan Reads the entire log file into the database and updates the display 
at the end of the scan period 

Ctrl+F /  

Goto Begin Sets the read position to the begin of the log file  

Goto End Sets the read position to the end of the log file  

Table 7: Player menu entries 
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6.1.1.5 Receiver 

 

Figure 14: Receiver menu entries 

Function Description Shortcut / Toolbar icon 

Port 

Defines the port u-center connects to. The list is generated 
automatically using the enumeration method under Tools  
Preferences  Generic Enumerate serial ports using. 

The currently used port will be indicated with a . 

 

Disconnect Disconnects from a connected receiver  

COM [1…9] Connects to COM[1…9] with the current baud rate. Ctrl+[1…9] 

Network connection Connects to a receiver through network.  

Baud rate 

Defines the baud rate of the communication. The list is pre-defined 
and cannot be changed. 

The currently set baud rate will be indicated with a . 
 

Location API Connects to the receiver using the Location API  

Sensor API 
Connects to the receiver using the Sensor API (the USB Sensor 

driver is required in this case) 
 

Autobauding 
Enables or disables autobauding for the current communication 
with the receiver 

 

Debug Messages 
Enables all debug messages in the receiver. Can be requested by 
the u-blox support.  
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Generation 
Defines the generation of the attached u-blox GNSS receiver. u-
center also tries to detect automatically the correct generation. 

 

Protocol Filter Sets the message filter against versions of protocol specification.  

Action 
Lists all possible actions that can be performed with the u-blox 
GNSS receiver. This includes the following: 

 

Hot start 
Sends a hot start command to the receiver. No data is deleted in 
the receiver.  

Warm start 
Sends a warm start command to the receiver. Only the ephemeris 
are deleted from the memory.  

Cold start 
Sends a cold start command to the receiver. All information is 
deleted from the memory.  

Save Config 
Saves the current receiver configuration to the memory so that it 

will be loaded after a restart.  

Load Config Loads the last saved configuration from the memory.  

Revert Config 
Deletes all configurations in the memory and reverts the receiver to 

the default configuration.  

Differential DGNSS 

Interface… 

Allows the streaming of RTCM messages to the receiver for high 

precision applications. 
 

Epoch detection… 
Defines which time information determines the boundary of an 
epoch detection in u-center. 

 

Table 8: Receiver menu entries 

6.1.1.6 Tools 

 

Figure 15: Tools menu entries 

Some of the menu items will only be displayed when the correct receiver generation is connected and identified 

by u-center. If you cannot select one option, change the receiver generation under Receiver  Generation. 
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Function Description Shortcut / Toolbar icon 

Firmware Update u-
blox 5 - 8… 

Opens the firmware update dialog for u-blox 5 - 8 generation 

receivers. 

Ctrl+U 

Dump Receiver 
Diagnostics… 

Tool to create the receiver diagnostic. Can be requested by the u-
blox support team. 

 

u-blox 7/8/M8 
Retrieve Log… 

Opens the dialog to download log information from the receiver. 

This is supported only since u-blox 7 receivers. 

 

AssistNow Offline Opens the AssistNow Offline dialog. Please switch over to 
AssistNow Offline as the legacy service is marked deprecated. 

 

AssistNow Online Opens the AssistNow Online dialog Please switch over to 

AssistNow Online as the legacy service is marked deprecated. 

 

GNSS 
Configuration… 

Opens the dialog to save the receiver configuration to a file on the 
PC or to restore a configuration from a file on the PC. 

 

File transfer… Opens File Transfer to Receiver dialog  

Preferences… Opens the dialog for the u-center preferences.  

Table 9: Tools menu entries 

6.1.1.7 Window 

 

Figure 16: Window menu entries 

Function Description Shortcut / Toolbar icon 

Cascade Arranges all open dialogs cascaded.  

Tile Horizontally Arranges all open dialogs horizontally.  

Tile Vertically Arranges all open dialogs vertically.  

Close All Closes all open dialogs and windows.  

Save Workspace 

As… 

Allows to save the position of the open dialogs and windows to a 

file on the computer. 

 

Restore Workspace 
From… 

Allows to restore the position of the dialogs and windows from a 
file on the computer. 

 

Recent Workspace Lists all recently used workspace files.  

Arrange Icons Arranges the icons at the bottom of the window.  

List of dialogs and 
windows 

Lists all visible and hidden dialogs and windows in u-center.  

Table 10: Window menu entries 
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6.1.1.8 Help 

 

Figure 17: Help menu entries 

Function Description Shortcut / Toolbar icon 

Contents… References to this user guide. F1 

About u-center… Shows the about dialog with the software version and the used 
libraries and their versions. 

 

Table 11: Help menu entries 

6.1.2 Standard toolbar 

The standard toolbar gives access to standard operations like opening and saving files, print the current view or 

empty the database. 

 

Figure 18: Standard toolbar entries 

6.1.3 Views toolbar 

 

Figure 19: Views toolbar entries 
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6.1.4 Communication toolbar 

 

Figure 20: Communication toolbar entries 

6.1.5 Log file toolbar 

 

Figure 21: Log file toolbar entries 

6.1.6 Action toolbar 

 

Figure 22: Action toolbar entries 

6.1.7 Standard status bar 

The standard status bar is updated automatically and shows the information about the opened file, the 

connection and the time. 

The following fields are available:  

Status display: Displays the current action or the function of a button if the mouse cursor is over the button 

DGNSS information: Shows the connection to a DGNSS source (only when activated through Receiver  
Differential GNSS Interface…) 
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Receiver generation: u-center tries to automatically detect the type of device connected and activates the 
appropriate mode of operation in order to take optimal advantage of the features. The mode can also be 

manually selected through the menu bar (Receiver  Generation). 

Port information: Shows the active COM port and baud rate. 

Color coding of the icon: 

 Disconnected 

 Waiting for first data 

 Data is being received but errors are detected (mostly because of wrong baud rate settings) 

 Last data received was valid but there is no data to collect at this time 

 No data is being received but errors have been detected in the past 

 Data is being received and collected at the correct baud rate 

File: As soon as a file is used (this file must first be opened) the name of the file will be displayed (xxxxxx.ubx). 

Protocol information: This box indicates the current message set that is being used to communicate with the 

device. This can be the NMEA-0183 standard or the UBX protocol. The UBX protocol provides more 
extensive information with the receiver. u-center can handle both protocols. 

Operating time: The time elapsed since you started u-center. 

UTC time: The current time sent by the device. This field is only updated if a receiver is connected. 

Receiver status: Shows the last known status of the receiver 

  Color coding of the icon: 

Power status of receiver is unknown 

Receiver is powered on 

Receiver is powered off 

6.2 Views and windows 

6.2.1 Packet console 

The packet console lists all incoming and outgoing messages, and provides information about message length 

and type. The direction of the message is shown in the following way:-  

R <- Indicates the message was sent to the receiver 

R -> Indicates the message came from the receiver 
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Figure 23: Packet console 

Refer to Table 12 for an explanation of the icons and text fields. 
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6.2.2 Binary console 

The binary console lists all incoming messages in binary and ASCII format.  

 

Figure 24: Binary console 

Refer to Table 12 for an explanation of the icons and text fields. 
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6.2.3 Text console 

The text console displays the content messages in textual form such as UBX-INF or NMEA messages. 

NMEA messages are shown with heading $Gxyyy, where x stands for the satellite system (P = GPS, SBAS, QZSS, 

L = GLONASS, A = Galileo, B = BeiDou, N = Any combination of GNSS) and yyy for the type of message (e.g. 
ZDA=Time & Date). 

 

Figure 25: Text console displaying UBX-INF and NMEA messages. Last part has “Show PC Time” enabled 
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Element Name Description 

/  
Lock / Locked 

Prevents the console from being updated with new data when locked. 

Pause key can be used to Lock/Unlock the current console window. 

 
Clear All Erases all data in the console 

 
Show/Hide PC time Shows/Hides the PC time in the console. See Figure 25 for an example. 

6.2.4  
Filter On/Off 

Filters unwanted data from the data stream. This allows searching for 

certain expression, e.g. all RMC messages (). 

 
Pause player 

Pauses the player when the search expression is found. Only works in 
playback mode. 

Table 12: Description of the buttons of the console views 

6.2.4.1 Regular expression evaluation 

Normally, when you search for a sub-string in a string, the match should be exact. So if we search for a sub-

string "abc" then the string being searched should contain these exact letters in the same sequence for a match 
to be found. We can extend this kind of search to a case insensitive search where the sub-string "abc" will find 

strings like "Abc", "ABC" etc. That is, the case is ignored but the sequence of the letters should be exactly the 

same. Sometimes, a case insensitive search is also not enough. For example, if we want to search for numeric 
digit, then we basically end up searching for each digit independently. This is where regular expressions come in 

to our help. Regular expressions are text patterns that are used for string matching. Regular expressions are 

strings that contain a mix of plain text and special characters to indicate what kind of matching to do. Here's a 
very brief tutorial on using regular expressions.  

Suppose, we are looking for a numeric digit then the regular expression we would search for is "[0-9]". The 

brackets indicate that the character being compared should match any one of the characters enclosed within the 
bracket. The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this regular expression 

will match any character between 0 and 9, that is, any digit. If we want to search for a special character literally 

we must use a backslash before the special character. For example, the single character regular expression "\*" 
matches a single asterisk. In the table below the special characters are briefly described. A regular expression 

search is case sensitive. 

Character Description 

^ Beginning of the string. The expression "^A" will match an “A” only at the beginning of the string. 

[^ 
The caret (^) immediately following the left-bracket ([) has a different meaning. It is used to exclude the 
remaining characters within brackets from matching the target string. The expression "[^0-9]" indicates 
that the target character should not be a digit. 

$ 
The dollar sign ($) will match the end of the string. The expression "abc$" will match the sub-string 
"abc" only if it is at the end of the string. 

| 
The alternation or logic OR character (|) allows either expression on its side to match the target string. The 
expression "a|b" will match “a” as well as “b”. 

. The dot (.) will match any character. 

* 
The asterisk (*) indicates that the character to the left of the asterisk in the expression should match 0 or 
more times. 

+ 
The plus (+) is similar to asterisk but there should be at least one match of the character to the left of the 
+ sign in the expression. 

? The question mark (?) matches the character to its left 0 or 1 times. 

() The parenthesis affects the order of pattern evaluation. 

[] 
Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may match 
the target character. 
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Table 13: Regular expression syntax 

6.2.4.2 Example 

Let’s assume that the following lines would appear in the NMEA console without filtering.  

 

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34 

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:03 $GPGSV,2,1,07,06,58,062,44,17,52,161,44,25,45,239,44,22,35,301,44*7F 

14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33 

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:04 $GPGSV,2,1,07,06,58,062,45,17,52,161,44,25,45,239,44,22,35,301,44*7E 

14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201,,*0D 

14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B 

 

In the following examples the characters marked red match the regular expression. 

 

Example 1: Searching for the RMC with a valid position and all GGA Messages 

“GP(GGA|RMC,.*,A,)” 

 

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201,,*0D 

 

 

Example 2:  Searching for all GSV with the message index of “2” or “3” 

“GSV,.*,[2-3],” 

 

14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

l14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

 

Example 3:  Searching for all messages starting with $GP, which have a “G” in the message identifier but 

not at the first position  

“^\$GP.+G.*,” 

 

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B 

 

 

Example 4:  Searching for all message having a checksum of which the higher nibble is 3 

“\*3.$” 

 

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34 

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33 

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

 

 



u-center - User Guide 

UBX-13005250 - R11 Production Information u-center menus and windows 

  Page 32 of 62 

6.2.5  Messages View 

The messages view is utilized to communicate with the device. Receiver output messages (e.g. navigation 

output, status and debug information) are displayed; input messages (e.g. configuration messages) can be sent. 

There are different sections for NMEA and UBX protocol.  

 

 

Figure 26: Message View 

Element Name Description 

/  
Lock / Locked Prevents the message view from being updated with new data when 

locked. Pause key can be used to Lock/Unlock the current view window. 

 
Clear All Erases the entire message view. 

 
Send Sends the current message to the device. 
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Poll Polls the selected message once. 

 
Auto poll Automatically polls a newly selected message once  

 
Message Hotkey Assigns a hotkey to the selected message 

Table 14: Description of the buttons in the messages view toolbar 

6.2.5.1 Receiver output messages 

 

Figure 27: Message display of an output message 

 Double-clicking on an output message enables or disables the periodic message update if the 
communication protocol is active. This feature is currently only supported for the UBX protocol. 

6.2.5.2 Receiver input messages 

Input messages can be edited and sent to the device from the messages view. It is also possible to poll the 

current receiver settings.  
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 u-center performs some range checks on input messages. If an input value exceeds the permitted range, 
u-center will highlight the field in red but it is still possible to send the value to the receiver. However, the 
receiver is likely to reject such a message. 

6.2.6 Statistic view 

 

Figure 28: Statistic View 

All available database values (transmitted from the device or calculated by u-center) are displayed. The following 

statistics are displayed: 

 Current value 

 Minimum value 

 Maximum value 

 Average value 

 Standard Deviation  

The following color scheme for the values is applied: 

 Grey color: The value was not set for the current epoch 

 Blue color: The value was calculated by the application from other data 

 Empty field: No data is available 

 Choosing “Database Empty” in the file menu or pressing the button  clears the statistic view. 
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 The content of the statistic view can easily be exported to other programs using Copy/Paste. 

6.2.7 Table view 

 

Figure 29: Table view 

All values from the database can be displayed in a tabular form (Figure 29). This is very useful when analyzing 

the log file in detail. 
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To add a new column, first select the desired value (Figure 30) and click the  button. To remove a displayed 

value, click the  button. To see the table header click the  button. Statistical information will be shown.

 

 

Figure 30: Selecting a new value 

 The number of displayed epochs is set to 1800 by default (see also section 5.4). 

 Choosing “Database Empty” in the file menu or pressing the button  clears the table view. 

 The content of the table view can easily be exported to other programs using Copy/Paste. 
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6.2.8 Map view 

u-center can display positions on pre-calibrated maps (Figure 31). This allows a basic analysis of road tests. 

 

Figure 31: Map view 

6.2.8.1 Using map view 

You can access the view specific commands in two different ways: 

 Using the command in the tool bar below the map view. 

 Holding the cursor inside the map view and pressing the right mouse button will. This will open the 
following context menu (see Figure 33). 
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Figure 32: Map view context menu 

Function Description Shortcut / Toolbar icon 

Cursor 

The position of the cursor is shown on the lower left edge of 
the u-center screen (Longitude, Latitude and Pixel-Position). By 

holding the left mouse button and moving the cursor over the 
map you can measure distance from one position to another 

 

Move The map inside the map view window can be moved  

Zoom In The map is enlarged by selecting a rectangle  

Zoom Out The size of the Map is decreased  

Zoom Factor Different specific zoom level can be selected   

Fit Map The map size is adjusted to fit the Map Window  

Markers 
Add or remove the defined markers (see also section 6.2.8.2, 
Map calibration)  

Follow Center the map on the current GNSS position  

Drawing Mode 

The size and form of the displayed position can be changed; 

the connection line between the points can be selected in the 
menu Connect. To see statically values (average, minimum, 
maximum, standard deviation) directly in the map, select the 
Menu Statistic.  

 

Open Map… / 
Recent Maps 

Load a new or one of 8 recently used maps.   

Copy   

Save map  

(only in toolbar) 
The current display can be stored in different formats  /  

Image settings 

(only in toolbar) 

Brightness, contrast and color saturation of map can be 
adjusted by moving the glides  

Table 15:  Description of the buttons and context menu entries in map view  

 Map Views can be copied to the clipboard using the “Print Screen” function. 

 Choosing “Database Empty” in the file menu or pressing the button  deletes all recently displayed 
positions and routes. 
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6.2.8.2 Map calibration 

To create your own map you will need a digitized map or pictures with orthogonal projection in one of the 

following pixel graphics formats.  

png  Portable Network Graphics,  

bmp  Windows Bitmap 

dib   Device Independent Bitmap  

gif  Graphics Interchange Format 

jpg/jpeg Jpeg File Interchange Format 

pcx  PC paintbrush 

tif  Tag Image File Format 

If your map is not in one of the above formats, you can simply convert it in one of the supported formats by a 

third party program. u-blox provides two sample maps. Office.png is a small map of the surroundings of the u-

blox headquarters. World.png is a map of the whole world but with limited resolution. 

To use a map in u-center, three calibration points are needed. For these points you have to know the pixel 

coordinates and the according WGS84 coordinates in the latitude/longitude format in degrees (longitude: -180.0 

to 180.0, latitude: -90.0 to 90.0). These points are stored in the map calibration file. The calibration file must be 
stored at the same location as the bitmap itself. It has the same name but a different extension (*.mcf). The 

format of the calibration file is very simple and can be edited in a simple editor like notepad.  

Examples: 

As an example we will have a closer look at the provided map “world.png” and its calibration file “world.mcf”.  

       

Figure 33: Digital map file: world.png 

The Map has 1765 Pixels (0 to 1764) in the horizontal and 1046 Pixels (0 to 1045) in the vertical direction. The 

origin is the upper left corner. To calibrate this map we will use the following three calibration points (#1 to #3). 

 

  Pixel WGS84 Coordinate 

Reference Point  # X Y Longitude Latitude 

Upper Left Corner 1 0 0 -180.0 90.0 

Lower Right Corner 2 1764 1045 180.0 -90.0 

Upper Right Corner 3 1764 0 180.0 90.0 

 

To determine the exact pixel position you can use Microsoft Paint (mspaint.exe) or any other pixel-editing 
program. 

Y/X 
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The calibration file is a plain ASCII text file. The file may contain comments. The file consists of two sections, 
which start with keywords encapsulated in braces. 

The REFERENCE section, which is mandatory, contains the three points used to calibrate a map. Each reference 

point is on a single line and has the following syntax: 

“# = <x>, <y>, <lon>, <lat>” 

where # is the index of the reference point <x> is the horizontal and <y> is the vertical image coordinate and 
<lat> is the latitude and <lon> is the longitude in degrees and WGS84. 

The optional MARKER section defines additional points on the map. Each point is on a single line with the 

syntax: 

“# = i, <x>, <y>[, <text>]” or “# = c, <lat>, <lon>[, <text>]” 

where # is the index of the marker point <x> is the horizontal and <y> is the vertical image coordinate or <lat> 
is the latitude and <lon> is the longitude in degrees and WGS84. <text> is a optional string in quotes labeling 

the marker point. The points must have a unique index from 1 to <num>. The maximum marker point index 

<num> is written to the same section on a separate line with the syntax “Count = <num>”.  

 

; I N F O 

; ------------------------------------------------------------ 

; File:   world.mcf 

; Source: (sample data set) 

 

 

; R E F E R E N C E  

; ------------------------------------------------------------ 

; 3 Points must be defined to calibrate a Map 

; Parameters: 

;   #       = index of the point (1 to 3) 

;   x,y     = image coordinates 

;   lat,lon = world coordinates 

; Syntax:  

;   # = <x>, <y>, <lon>, <lat> 

 

[REFERENCE] 

1 =    0,     0,  -180.0,  90.0 

2 = 1764,  1045,   180.0, -90.0 

3 = 1764,     0,   180.0,  90.0 

 

 

; M A R K E R 

; ------------------------------------------------------------ 

; You can add points (image or world coord) to the map   

; Parameters: 

;   num     = number of markers that follow 

;   #       = index of the point (1 to num) 

;   type    = c for world or i image coordinates 

;   x,y     = image coordinates 

;   lat,lon = world coordinates 

;   text    = quoted text decription to the marker (optional) 

; Syntax:  

;   Count = <num> 

;   #     = <type>, <x|lon>, <y|lat>[, <text>] 

 

[MARKER] 

Count = 1 

1 = c, 8.56525, 47.28519444, "u-blox ag" 

 

Map calibration file: world.mcf 
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6.2.8.3 Map calibration tool 

u-center includes a built-in calibration tool for providing coordinates to maps and photographs in supported data 

formats to create u-center maps. To use the tool open the map view window as seen in Figure 34 and then as 

seen in Figure 35 open the file of the map to be calibrated (in our example GoogleScreenShot.bmp). 

 

Figure 34: Opening map view window 

 

Figure 35: Opening the file of the map to be calibrated 

If the file to be opened has not been calibrated, the following message will appear: 
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Select three points on the map and enter the calibration coordinates in the specified format as seen in Figure 36, 
Figure 37 and Figure 38. 

 

Figure 36: Calibrating a map using calibration tool (position 1) 

 

Figure 37: Calibrating a map using calibration tool (position 2) 
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Figure 38: Calibrating a map using calibration tool (position 3) 

Following these steps the map is now calibrated and can be used with u-center for visualizing road tests etc.  
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6.2.9 Chart view 

Chart view allows the user to conveniently view GNSS data records in graphical form. The data can be scaled in 

many different ways and formats. It’s even possible to print the entire chart. 

The examples below illustrate two different typical applications 

 

Figure 39: Altitude as a function of Index (X = Index, Y = Alt) 

 

Figure 40: Latitude as a function of longitude (X =Longitude, Y = Latitude) 
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Function Description Toolbar icon 

Cursor 

The position of the cursor is shown on the lower left edge of the u-center 
screen (Longitude, Latitude and Pixel-Position). By holding the left mouse 
button and moving the cursor over the chart you can measure distance 
from one position to another 

 

Move The chart inside the chart view window can be moved  

Zoom In 
Drawing a rectangle enlarges the chart to the new view. To zoom in the 
chart double-click on the chart.  

Zoom Out 
Drawing a rectangle decreases the chart to the new view. To zoom out 
the chart double-click on the chart.  

Drawing Mode 

The size and form of the displayed values can be changed in the menu 
points; the connection line between the values can be selected in the 
menu connect. For viewing the statically values (average, minimum, 

maximum, standard deviation) directly in the chart select the statistics 

menu 

 

Fit Y range Fits the Y range  

Follow Y 
Follow the most current Y value (the most current Y-value is always in the 
middle of the chart)  

Index or Y value Switch between the index and the Y value  

Y value Select the Y value to be displayed 
 

Fit X range Fit the X range  

Follow X 
Follow the most current X value (the most current X value is always in the 
middle of the chart)  

Index or X value Switch between the index and the X value  

X value Select the X value to be displayed 
 

Moving average 
Adds a moving average. The average is calculated over the number of 
most recent values, specified with the parameter.  

Table 16: Description of the buttons and displays in Chart View 

 The number of displayed epochs is set to 1800 by default (see also section 5.4). 
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6.2.10 Histogram view 

Histogram views allow the user to view GNSS data and probability distributions (Figure 41) and print the entire 

histogram if desired. The number of bins (storage containers) can be set by the user.  

 

Figure 41: Altitude Histogram View 



u-center - User Guide 

UBX-13005250 - R11 Production Information u-center menus and windows 

  Page 47 of 62 

 

Figure 42: Probability chart 

 The number of displayed epochs is set to 1800 by default (see also section 5.4). 

 

Function Description Toolbar icon 

Cursor 

The position of the cursor is shown on the lower left edge of the u-center 
screen (Longitude, Latitude and Pixel-Position). By holding the left mouse 
button and moving the cursor over the histogram you can measure distance 

from one position to another. 

 

Move The histogram inside the histogram view window can be moved.  

Zoom In 
Drawing a rectangle enlarges the histogram to the new view. To zoom in the 
histogram double-click on the histogram.  

Zoom Out 
Drawing a rectangle decreases the histogram to the new view. To zoom out 
the histogram double-click on the histogram.  

Drawing Mode 

The size and form of the displayed values can be changed in the menu 

points; the connection line between the values can be selected in the menu 
connect. For viewing the statically values (average, minimum, maximum, 
standard deviation) directly in the histogram select the statistics menu. 

 

Probability Displays the probability histogram (see Figure 39). 
 

Fit Probability Fit the Probability range.  

Y value Select the Y value to be displayed 
 

Bins The number of bins 
 

Table 17: Description of the buttons and displays in histogram view 
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6.2.11 Camera view 

The camera view function enables photographs, taken during recording of log files, to be linked to the GNSS 

data stored in the corresponding log files. This allows a video depiction of the test, with a picture assigned to a 

specific point of GNSS data. 

 

Figure 43: Camera view 

 Using Camera View can result in very large log files and can slow down u-center when playing such files. 
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6.2.12 Deviation map 

The deviation map displays positions in longitude and latitude relative to a defined reference position.  

 

Figure 44: Deviation Map 

Function Description Toolbar icon 

Properties 

7 The reference position can be defined as:  

- The average of all previously measured positions 

- The current position 

- A fixed, predefined value  

- The radius of the outer circle can be adjusted with the Max. 

Deviation parameter. 

 

Fit 
Automatically adjusts the reference position and the maximum deviation 
to fit all positions into the deviation map.  

Track Show track of values from the internal database. 
 

Statistics Show statistics of the values from the internal database.  

Maximum deviation 
shortcut 

Shortcut for changing the scale of the deviation map to prefixed values. 
The icons represent Roman numerals, with “I” corresponding to a 1 m 
radius of the deviation map, and “V”= 5 m, “X”= 10 m, “L”= 50 m,  
”C” = 100 m, “D” = 500 m, and “M” = 1000 m.. 

 

Reference position 
shortcut 

Shortcut for setting the reference position: 

- A = average position 

- C = current position 

 

Table 18: Description of the buttons and displays in Deviation Map 

 The number of displayed epochs is set to 1800 by default (see section 5.4). 

 You can use the mouse scroll wheel to zoom in/out on the deviation map. Holding down the Shift key 
allows you to zoom in beyond the default 1 m maximum zoom. 



u-center - User Guide 

UBX-13005250 - R11 Production Information u-center menus and windows 

  Page 50 of 62 

7.1.1 Sky view 

Sky view is an excellent tool for analyzing the performance of antennas as well as the conditions of the satellite 

observation environment. The polar plot graphically displays the averaged relative satellite signal strength (see 

Figure 45), the position of satellites in the sky, identifies satellites by number and indicates which satellites are 
being used in the receiver calculation (see section 3.1). Right-clicking the mouse on sky view allows the copying 

of C/N0 values in tabular form to another program. 

 

Figure 45: Sky view 

Function Description Toolbar icon 

Linear projection 8 Displays the sky view with a linear projection. 
 

Sine projection Displays the sky view with a sine projection. 
 

C/N0 Displays or hides the averaged C/N0 values. 
 

Orbits Displays or hides the satellite orbits. 
 

Satellites Displays or hides the current satellite positions. 
 

Coordinates Displays or hides the caption for the azimuth. 
 

Elevation Displays or hides the caption for the elevation. 
 

Table 19: Description of the toolbar in sky view 



u-center - User Guide 

UBX-13005250 - R11 Production Information Tools 

  Page 51 of 62 

9 Tools 
This section will give an overview of the embedded tools of u-center. They can be used for different purpose and 

should facilitate the usage of u-blox GNSS receivers. 

The tools can be found under the “Tools” menu but some of the options are only displayed when a receiver is 

connected to u-center. The firmware update tools also depend on the connected receiver generation. 

 

Figure 46: Tools menu entries 

 

9.1.1 Firmware Update u-blox 5 - 8… 

This tool will allow you to update the firmware of a receiver. This only works if your receiver has a flash memory 

attached as the firmware has to be stored in this location. 

Perform the following steps to update the firmware: 

1. Establish the serial communication between u-center and the device (see also section 2.4). 

2. Open firmware update tool by clicking on Tools  Firmware Update u-blox 5/6/7/M8… 
 

 

Figure 47: u-blox 5 Firmware update window 

3. Select the firmware image suitable for the connected receiver. 
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4. Select the flash definition file (only needed before u-blox receiver generation 7). This file should be provided 
bundled with u-center. Point to the latest file version.  

5. Select the flash information structure file (only needed after and including u-blox receiver generation 7). This 

file should be provided bundled with u-center. Point to the latest file version.  

6. Select the correct options for your receiver: 

 

Option Description Recommended 

Use this Baud rate for update Selects the speed of the communication for updating the firmware 
on the receiver. 

Only has an effect when the receiver is connected over a serial 
port. 

115200 

Clear BBR before update Deletes the complete battery backed memory (BBR) so that the 
receiver will start with the default configuration. 

enabled 

Program FIS only Writes only the flash information structure (FIS) into the external 
memory and does not update the firmware. This option is used for 
receivers running from ROM but with an attached SQI memory (for 
example for logging). 

Only supported after and including u-blox receiver generation 7. 

disabled 

USB alternative update method Erases the first sector of the flash memory and restarts the receiver. 
The receiver will then start from ROM and the flash firmware can 

be updated. 

Use this method if you want to update the firmware of a receiver 
connected over USB. 

disabled 

Enter Safeboot before update Sends the command to enter safeboot. In this state, the receiver 
boots from the internal ring oscillator and does not rely on any 
external components. GNSS functionality is not started and the 
receiver does not output any data. 

Don’t use this method when having the receiver connected over 

USB. 

enabled 

Send Training sequence Sends the training sequence after safeboot was entered. This 
synchronizes the internal ring oscillator so that a communication 
can be established. 

enabled 

7. Click on “OK”. 

9.1.2 Dump receiver diagnostics  

This tool is used to dump the receiver diagnostic to a file. Use this tool if requested by the support team. 

 

Figure 48: Dump receiver diagnostics tool 
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9.1.3 GNSS configuration  

u-center is capable of getting the actual configuration of a u-blox GNSS positioning chip or module and storing 

it to an ASCII text file containing hexadecimal records. Such a file can be edited and stored to a u-blox GNSS 

device again. By clicking the menu “Tools -> GNSS Configuration...” of u-center, the GNSS Configuration dialog 
opens. The following functions are available: 

 

Figure 49: GNSS configuration tool 

- Specify the name of a new configuration file to store current configuration from the u-blox GNSS 

device 
- Specify the name of an existing configuration file and load this configuration into the u-blox GNSS 

device 

- A flag can be set to force storing the configuration into the Battery Backed RAM (BBR) or Flash. 

9.1.3.1 Read/Write configuration files 

1. Connect to the device. 

2. Open Tools / GNSS Configuration. 

3. To read an existing configuration file, select the name of the file, then click on “File > GNSS” button. The 

GNSS Configuration window then closes and the progress window pops up, showing the configuration 

being sent to the receiver. This progress window closes after finishing the transfer without error. 

 Select “store configuration into BBR/Flash” checkbox if the parameters need to be stored into the device’s 

non-volatile memory (BBR/Flash). 

 Sending a configuration to a u-blox GNSS device may fail due to a baud rate change on the current serial 
port of the receiver to which the configuration is being sent. If this happens, simply change the u-center 

baud rate and send the configuration again. 

To write a new configuration file, click on “GNSS > File”. The GNSS Configuration window closes and the 
progress window pops up, showing the configurations being polled and stored into a local file in ASCII format. 

If reading or writing configuration data fails too frequently, try to increase the number of retries u-center should 

do on a single message if one fails. 

The user can abort the transfer by clicking the “Abort” button. It’s not possible to close the window unless 

transfer has completed or the user aborted it. 

 It is not recommended to read/write configuration while the u-blox GNSS device is in sleep mode. 
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9.1.3.2 Editing configuration file 

 

Figure 50: Content Configuration File 

When clicking the “Edit” button in the GNSS Configuration dialog, the Notepad editor opens (standard 
Windows software). Configurations are stored the following way: 

 The first line contains the version of the u-blox GNSS receiver where the configuration is from. Never 
change this line! 

 For the second and following lines, each line contains the same: <class ID>-<message ID> - 

<hexadecimal byte code of the message>. The byte code consists of class and message IDs (2 bytes), 
payload length (2 bytes), payload (payload length bytes). The sync characters and the checksum are not 

included. They will be calculated automatically.  

Refer to u-blox Receiver Description including Protocol Specification for detailed information and ranges. 

9.1.4 Hotkeys 

The Tools Menu allows administrating the Hotkeys defined in the Message View. Refer to section 6.2.5 for more 

information on the Hotkeys. 

9.1.5 Preferences 

The preferences tool can be used to configure a number of u-center parameters. 
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10 How To 

10.1 Change baud rate of receiver 

1. Connect to the device. 

2. Open View / Messages View (Hotkey: F9). 

3. Select UBX-CFG-PRT. 

4. Poll the current configuration from the receiver ( ). 

5. Change the setting to the desired baud rate. 

6. Send the message to the receiver ( ). 

 

Figure 51: Changing baud rate (using UBX-CFG-PRT) 
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10.2 Save parameters to receiver non-volatile memory (BBR/Flash) 

There are 2 ways to save parameters to the receiver’s non-volatile memory (BBR/Flash). 

10.2.1 Saving parameters with UBX-CFG-CFG 

1. Connect to the device. 

2. Open View / Messages View (Hotkey: F9). 

3. Select UBX-CFG-CFG. 

4. Select “save current configuration” (see Figure 52). 

5. Send the message to the receiver ( ). 

 

Figure 52: Saving Parameters (using UBX-CFG-CFG) 

10.2.2 Saving parameters with GNSS configuration 

Refer to 9.1.3.1 step 3 

10.3 Recording/playing a log file 

u-center allows recording and playing log files. Use the player controls, to record or playback a log file. Select the 
log file to be opened through the file menu tool bar. The series of buttons in the player toolbar can be used to 
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navigate through the log file. The records will be displayed on the navigation display window, in the same way 
that live GNSS data is displayed when using u-center.  

10.4 Conduct sensitivity tests 

u-center is a useful tool for conducting sensitivity tests of GNSS positioning chips and modules and receiver 

designs. To do so, under open sky conditions record a log file of the receiver to be tested and an Evaluation Kit 

as reference. Make sure that the log files are recorded under the same conditions. Using the Statistic View or 
Table View windows from u-center, compare the C/N0 values of the five strongest satellites. With Table view, 

export the values to a spreadsheet for analysis. 

10.5 Read/write configuration files 

Refer to 9.1.3.1. 

10.6 Set GNSS system configuration 

1. Connect to the device. 

2. Open View / Messages View (Hotkey: F9). 

3. Select UBX-CFG-GNSS. 

4. Place or remove the checkmark for the desired GNSS under “enable”. 

5. Send the message to the receiver ( ). 

 

The following Figure 53 shows an example that configures the device to receive only GLONASS. 

 

Figure 53: GNSS configuration (using UBX-CFG-GNSS) 
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10.7 Activating PPP (EVK-6PPP only) 

1. Connect to the device. 

2. Open View / Message View. 

3. Select UBX-CFG-NAVX5 window. 

4. Place or remove the checkmark for “Use PPP”. 

5. Send the message to the receiver ( ). 

 

 

Figure 54: How to activate and deactivate PPP using UBX-CFG-NAVX5 
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10.8 Change Epoch Detection Method 

u-center looks for epochs in the incoming messages from the receiver, and uses them as a “heartbeat” to trigger 

view updates and calculate the statistics. To detect new epochs, u-center examines various groups of fields in the 
incoming message stream. It is possible to specify which field groups u-center is interested in for epoch 

detection, and opening the dialog under “Receiver”  ”Epoch detection...” allows the user to do this. 

 

 

Figure 55: Select epoch detection method 

Where the following options can be configured: 

Option Description Default 

iTOW Monitor the “iTOW” database element. Trigger an epoch if a difference is seen. 

Typically UBX-NAV messages cause this trigger. 

Yes 

HNR TOW Monitor the “NAV-HNR iTOW” database element. Trigger an epoch if a 
difference is seen. HNR based messages cause this trigger. 

No 

UTC-TIME Monitor the “UTC” database element. Trigger an epoch if a difference is seen. 

Typically NMEA messages cause this trigger. 

Yes 

GPS-TIME Monitor the “GPS time” database element. Trigger an epoch if a difference is 
seen. Typically PUBX messages cause this trigger. 

Yes 

NAV-EOE Monitor for incoming UBX-NAV-EOE messages. Trigger an epoch if one is seen. Yes 

ITFM Status Monitor the “ITFM Status” database element. Trigger an epoch if a difference is 

seem. The UBX-RXM-INTF message causes this trigger. 

Yes 

NMEA repeat Monitor for NMEA messages. Trigger an epoch if the same NMEA message is 
seen twice since the last epoch. Excluding GxGRS and GxGSA. 

Yes 

Table 20: Epoch detection method options 

The default configuration can be restored by clicking the “Restore historical defaults” button. 
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11 Troubleshooting 
NMEA or UBX protocol is not available in the Messages View 

u-center uses dynamic link libraries (DLL). The installation program will automatically install the required DLLs 
into the u-center program directory. Should you try to copy a u-center installation from one location to another, 

make sure you also copy the DLL files. Verify, the version of u-center matches the DLL version. 

u-center doesn’t display all messages 

Make sure the baud rate is sufficient. If the bandwidth is insufficient, receivers based on the ANTARIS™ 

Technology will skip excessive messages.  

Some serial port cards/adapters (i.e. USB to RS232 converter) frequently generate errors. If a communication 
error occurs during while u-center receives a message, the message will be discarded. 

u-center loses the connection to the device 

u-blox GNSS positioning chips and modules have an autobauding feature. If frequent communication errors 
occur (i.e. due to problems with the serial port), the connection may be lost as u-center and the device will 

autonomously try to adjust the baud rate. Do not enable the u-center autobauding feature if the device has the 

autobauding enabled. 

Some COM port are not shown in the port list 

Only the COM ports that are available on your computer will show up in the COM port drop down list. If a COM 

port is grayed out, another application in the computer is using it. 

PC is very slow when u-center runs 

If a high value of epochs is selected, the display in real-time cannot be guaranteed, especially when many 

graphical views are open. u-center does not update minimized views and console in real-time. Close or minimize 
as many of the graphical views and consoles as possible and u-center will run faster. 

Log file / Data are only partly displayed 

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of larger logfiles. The 
limitation is set to 1800 epochs by default. That means if an epoch is available every second you can analyze 

data for as much as 30 minutes. After this time the oldest values are discarded. Data stored to a log file are not 

affected by the database limitation. Refer to section 5.4 for instructions on how to increase this limit. 

When planning long-term observations, it’s recommended to start recording a log file before analysis begins.  

Output messages are not updated in the Messages View 

Make sure that the protocol you would like to receive is enabled. If so, double-click on the desired output 
message. Double-clicking on an output message enables or disables the periodic message update if the 

respective protocol is active. Alternatively, select the desired input or output message and press the “Poll” 

button. 

If you would like to get UBX-INF () messages in the log file, configure the receiver accordingly with the 

UBX-CFG-INF input message. 

No logfile is recorded 

After a new logfile is created, logging will not automatically start but only after selecting the Record button in 

the Player Toolbar. 
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Related documents 
[1] GPS Compendium, Doc No GPS-X-02007 

[2] u-blox 5 Receiver Description including Protocol Specification, Docu. No GPS.G5-X-07036 

[3] u-blox 6 Receiver Description including Protocol Specification, Docu. No GPS.G6-SW-10018 

[4] u-blox 7 Receiver Description including Protocol Specification V14, Docu. No GPS.G7-SW-12001 

[5] u-blox 8 / u-blox M8 Receiver Description Including Protocol Specification (Public version),  
Docu. No. UBX-13003221 

 

 For regular updates to u-blox documentation and to receive product change notifications, register on our 
homepage. 

 

Revision history 
 

Revision Date Name Status / Comments 

- 08-Oct-2008 tgri Initial release 

A 22-Jul-2009 tgri New CI 

A1 17-Feb-2011 tgri Third party libraries 

B 1-Nov-2011 tgri Google Earth View added 

C 03-Jun-2012 khir Updated for u-center 6.3. GNSS configuration added 

Last revision with document number GPS-SW-08007 

R06 09-Dec-2013 maba Update for u-center 8.01 and u-blox 7 and M8 generations 

R07 01-Oct-2014 jbow Packet view update describing message direction indicators 

R08 23-Feb-2015 zyha Updated menu pictures and shortcut key list corresponding to latest version. 

R09 04-Sep-2015 smos Updated Contact page 

R10 12-Dec-2015 maba Remove Google Earth support 

R11 29-Mar-2016 maba Epoch detection, DGNSS interface and receiver status icons description added, legacy 
aiding marked deprecated, pictures updated 
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Contact 
For complete contact information visit us at www.u-blox.com 

 

Offices     

North, Central and South America 

u-blox America, Inc. 

Phone: +1 703 483 3180 

E-mail: info_us@u-blox.com  

Regional Office West Coast: 

Phone: +1 408 573 3640 

E-mail: info_us@u-blox.com 

Technical Support: 

Phone: +1 703 483 3185 

E-mail: support_us@u-blox.com 

 
Headquarters  
Europe, Middle East, Africa 

u-blox AG  

Phone: +41 44 722 74 44 
E-mail: info@u-blox.com 

Support: support@u-blox.com 

 
Asia, Australia, Pacific 

u-blox Singapore Pte. Ltd. 

Phone: +65 6734 3811 

E-mail: info_ap@u-blox.com 
Support: support_ap@u-blox.com  

Regional Office Australia: 

Phone: +61 2 8448 2016 
E-mail: info_anz@u-blox.com 

Support: support_ap@u-blox.com 

Regional Office China (Beijing): 

Phone: +86 10 68 133 545 
E-mail: info_cn@u-blox.com 

Support: support_cn@u-blox.com 

Regional Office China (Chongqing): 

Phone: +86 23 6815 1588 
E-mail: info_cn@u-blox.com  

Support: support_cn@u-blox.com 

Regional Office China (Shanghai): 

Phone: +86 21 6090 4832 
E-mail: info_cn@u-blox.com  

Support: support_cn@u-blox.com 

Regional Office China (Shenzhen): 

Phone: +86 755 8627 1083 

E-mail: info_cn@u-blox.com 
Support: support_cn@u-blox.com 

Regional Office India: 

Phone: +91 80 4050 9200 
E-mail: info_in@u-blox.com 

Support: support_in@u-blox.com 

Regional Office Japan (Osaka): 

Phone: +81 6 6941 3660 
E-mail: info_jp@u-blox.com  

Support: support_jp@u-blox.com  

Regional Office Japan (Tokyo): 

Phone: +81 3 5775 3850 
E-mail: info_jp@u-blox.com  

Support: support_jp@u-blox.com  

Regional Office Korea: 

Phone: +82 2 542 0861 

E-mail: info_kr@u-blox.com  

Support: support_kr@u-blox.com 

Regional Office Taiwan: 

Phone: +886 2 2657 1090 

E-mail: info_tw@u-blox.com  
Support: support_tw@u-blox.com  

 

http://www.u-blox.com/
mailto:info_us@u-blox.com
mailto:support_us@u-blox.com

